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9/17/2015 1.5 Reformatting and consolidating documents. 

9/28/2015 1.6 Added Appendix D – renamed old Appendix D to Appendix E 

3/4/2016 2.0 Modified installation checklist to include all ETS applications 

Updated formatting & Fixed dead links 

Added Table of Contents 

Reordered & consolidated appendices – Added ETS-ALERT/SQL 2012 workaround (new Appendix D) 

 

Contents 
Downloads .............................................................................................................................................................................. 2 

Preferred Installation Order for ALL ETS Applications ............................................................................................................ 3 

Appendix A: Pre-requisite Installations Guide (Detailed) ....................................................................................................... 5 

1 - .NET Framework – KB3026376 ...................................................................................................................................... 5 

2 – ETS (KB2779272) ........................................................................................................................................................... 7 

3 – SAP Crystal Reports (64-bit – Service Pack 10) ............................................................................................................. 7 

4 – SAP Crystal Reports (32-bit – Service Pack 2) ............................................................................................................. 10 

5 – PDFNet Driver 1.0 ........................................................................................................................................................ 12 

6 – URL/ACL Reservation of Port :5555 ............................................................................................................................ 15 

7- SQL Server (2008 AND 2012) Silent Installation ........................................................................................................... 15 

8 – Microsoft SQL Server 2012 Express – Service Pack 2 (Upgrade from SQL 2008) ........................................................ 17 

Appendix B: Local Configuration of Port :5555 ..................................................................................................................... 23 

Appendix C: Firewall Configuration ...................................................................................................................................... 24 

Appendix D: ETS-ALERT Database Deployment Workaround for SQL 2012 ......................................................................... 28 

 

Federal Deposit Insurance Corporation 



ETS Pre-requisite Checklist (STATE) 
Version 2.0 

3/4/2016 

Do not alter or change the document without permission by the FDIC.   Page 2 of 28 

Downloads 
Link to CSBS Website – ETS Technical Requirements (contains important documents and scripts for state employees) 

https://www.csbs.org/regulatory/examtools/Pages/ETSTechnicalRequirements.aspx 

 

 

Item Version / Notes Where it can be found 

KB3026376 Hotfix Rollup This rollup will install .Net Framework (v4.5.2), KB3026376 and 

KB2974336 – which are all requirements for ETS.   

https://support.microsoft.com/en-us/kb/3026376#/en-

us/kb/3026376  

KB2779272 Hotfix Update adds support for some new glyphs and features in 

Windows 8 to common fonts in Windows 7 and in Windows Server 

2008 R2 

http://support.microsoft.com/kb/2779272  

SAP Crystal Reports for Visual 

Studio 2010 –  SP10 

Service Pack 10 – 64 bit 

Note: The 32-bit version of Crystal Reports is only needed if 

examiners intend on using ETS-ALERT and ETS side-by-side. 

http://downloads.businessobjects.com/akdlm/cr4vs2010/

CRforVS_redist_install_64bit_13_0_10.zip 

PDFNet  1.0 –driver that assists the library used in converting files to PDF http://pdftron.com/downloads/pdfnetDrivers.zip  

Microsoft Visual C++ 2010 
Redistributable Package 32 or 64 
bit 

This library is required for PDFNet to be installed correctly.  It 
should be included with the Win 7 install by default, however, we 
have seen some state users that needed this package installed in 
order for PDFNet to be installed successfully.  

32 bit: http://www.microsoft.com/en-
us/download/details.aspx?id=5555  
 
64 bit:http://www.microsoft.com/en-
us/download/details.aspx?id=14632 

URL / ACL Script for 

Collaboration 

The URLACL is a configuration setting that allows the ETS 

application to host a web service for local network data 

collaboration. 

Apply configurations via ETS-FREDDY: 

https://ets.fdic.gov/ets-freddy/  or See Appendix B 

SQL Server 2008 Express R2 **Refer to ETS-ALERT installation instructions for more 

information** 

Microsoft SQL Server 2008 Express R2 – Service Pack 2 

http://www.microsoft.com/en-

us/download/details.aspx?id=30438 

64-bit: SQLEXPRADV_x64_ENU.exe 

SQL Server 2012 Express  **Refer to Appendix A for installation instructions** 

**Refer to Appendix D for ETS-ALERT workaround** 

Microsoft SQL Server 2012  Express  (Service Pack 2) - 11.0.5058  

http://www.microsoft.com/en-

us/download/details.aspx?id=43351  

64-bit: SQLEXPRADV_x64_ENU.exe (1.9GB) 

‘FDIC2008’ SQL Server Instance 

Name 

**Refer to Appendix A for installation instructions** 

When installing SQL Server you need to set the instance name to 

“FDIC2008”. 

Please also follow additional steps for setup of Filestream and CLR. 

User in SQL Server Management Studio must also have DBCreator 

and BulkAdmin privileges to create the ETS database.  

If installation assistance is needed, please contact: 

Examiner Help Desk 

ehelp@fdic.gov 

1-877-334-2999 , then option 2 

 

Full Hard Drive Encryption All laptops must have full-hard drive encryption enabled using 

Bitlocker or similar Digital Loss Prevention (DLP) software (e.g. 

Check Point). 

 

Antivirus All laptops must have an antivirus software installed and running in 

“active scan” mode. 
 

https://www.csbs.org/regulatory/examtools/Pages/ETSTechnicalRequirements.aspx
https://support.microsoft.com/en-us/kb/3026376#/en-us/kb/3026376
https://support.microsoft.com/en-us/kb/3026376#/en-us/kb/3026376
http://support.microsoft.com/kb/2779272
http://downloads.businessobjects.com/akdlm/cr4vs2010/CRforVS_redist_install_64bit_13_0_10.zip
http://downloads.businessobjects.com/akdlm/cr4vs2010/CRforVS_redist_install_64bit_13_0_10.zip
http://pdftron.com/downloads/pdfnetDrivers.zip
http://www.microsoft.com/en-us/download/details.aspx?id=5555
http://www.microsoft.com/en-us/download/details.aspx?id=5555
http://www.microsoft.com/en-us/download/details.aspx?id=14632
http://www.microsoft.com/en-us/download/details.aspx?id=14632
https://ets.fdic.gov/ets-freddy/
http://www.microsoft.com/en-us/download/details.aspx?id=30438
http://www.microsoft.com/en-us/download/details.aspx?id=30438
http://www.microsoft.com/en-us/download/details.aspx?id=43351
http://www.microsoft.com/en-us/download/details.aspx?id=43351
mailto:ehelp@fdic.gov
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Preferred Installation Order for ALL ETS Applications 
Follow these steps to install all ETS applications (ETS, ETS-ALERT, ETS-FREDDY, ETS-Training) and their required 
pre-req’s on a new laptop.  Please consult the Appendices in this document for troubleshooting assistance. 
 
** Please contact the Examiner Help Desk at ehelp@fdic.gov or 1-877-334-2999, then option 2 for additional 
support ** 
 
Notes: 
**Suggested Operating System: Windows 7, 64-bit**   
**Windows XP is no longer supported by Microsoft** 
**Windows 8 & Windows 10: Minimal testing conducted thus far - we cannot guarantee performance** 
**ETS will work in a 32-bit environment (not v1.1), but we recommend a 64-bit computer for best results** 
 

ETS-FREDDY  
1. Install ETS-FREDDY (Detailed instructions available at https://ets.fdic.gov/ets-freddy/) 
 

ETS-ALERT  
ETS-ALERT Pre-requisite Checklist (v1.4) available on CSBS website for detailed information. 
Verify all Pre-requisite installations with ETS-FREDDY. 
 
2. Install .NET Framework (4.5 or later) 
3. Install Crystal Reports – Service Pack 2 (32-bit)  
4. Install Crystal Reports – Service Pack 10 (64-bit) 
5. Install SQL Server 2008 Express R2 (Service Pack 2) – SQLEXPRADV_x64_ENU.exe  

a. Verify SQL Compact CE, x86 AND x64, have been installed. 
b. Verify Service Pack 2 has been installed.  Upgrade to SQL 2012 will fail if missing. 
c. Verify FDIC2008 instance was installed 
d. Verify SQL Logins were created 
e. Verify Database Roles were applied (SysAdmin, BulkAdmin, DbCreator) 

6. Install ETS-ALERT 
a. Verify ETS-ALERT opens successfully before continuing. 
b. See Common Errors and Solutions for additional troubleshooting information 

 

ETS-Training 
Install ETS-Training before upgrading to SQL Server 2012. 
Note: This is not a requirement, rather a recommendation.  You can install ETS-Training before or after 
upgrading to SQL 2012.  However, for best results, we recommend installing it before 
7. Install KB3026376  

a. Installs .NET Framework 4.5.2 
b. Installs Hotfix Rollup KB3026376 
c. Installs KB2974336 

8. Install KB2779272 
9. Install PDFNet 1.0 Driver 
10. URL/ACL Reservation  

a. See Appendix B (Local Collaboration of Port :5555) for more information 

mailto:ehelp@fdic.gov
https://ets.fdic.gov/ets-freddy/
https://ets.fdic.gov/ETS-ALERT_ErrorsAndResolution.htm
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11. Apply Firewall configurations (enterprise-wide AND local exceptions may be required) 
a. Incoming TCP 5555 – peer-to-peer communications (exception) 

i. See Appendix C (Firewall Configurations) for more information 
b. Outgoing TCP 443 – Central Peer communications  
c. Incoming UDP 3702 – SOAP WS_Discovery protocol (exception) 

i. Follow the same instructions in Appendix C 
d. Outgoing UDP 3702 – SOAP WS_Discovery protocol (exception) 

i. Follow the same instructions in Appendix C 
e. ETS.exe added as a trusted site 

i. Add https://ets.fdic.gov/ under Tools > Internet Options > Security > Trusted Sites  
12. Install ETS-Training (https://ets.fdic.gov/ets-training/)  

a. 5% of installations may fail on first installation.  If an error message appears: 
i. Delete the ETS_Training Database from SQL Server 2008 

ii. Uninstall/Reinstall ETS-Training 
 

ETS  
13. Upgrade SQL Server 2008 Express R2 to SQL Server 2012 (SP2) 

a. Verify there are no pending restarts on the computer 
b. Verify Service Pack 2 for SQL 2008 is installed  

14. Open SQL Server Management Studio (2012) and Import all settings from 2008. 
15. Verify ALL firewall configurations (enterprise-wide AND local exceptions may be required) 

a. Incoming TCP 5555 – peer-to-peer communications (exception required) 
b. Outgoing TCP 443 – Central Peer communications  
c. Incoming UDP 3702 – SOAP WS_Discovery protocol (exception required) 
d. Outgoing UDP 3702 – SOAP WS_Discovery protocol (exception required) 
e. ETS.exe added as a trusted site  

16. Install ETS (https://ets.fdic.gov/ets/) 
a. 5% of installations may fail on first installation.  If an error message appears: 

i. Delete the ETS_Training Database from SQL Server 2008 
ii. Uninstall/Reinstall ETS-Training 

iii. See ETS Common Errors and Solutions for additional troubleshooting information 
17. Have examiner log into ETS to activate their ETS user profile: 

a. Username 
b. Password 
c. PIN (hard-token) 

i. Soft-token: PIN number required to obtain OTP 
d. One Time Password (OTP) 

 
 

https://ets.fdic.gov/
https://ets.fdic.gov/ets-training/
https://ets.fdic.gov/ets/
https://ets.fdic.gov/ets/faq/ETS_CommonErrorsandSolutions.pdf
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Appendix A: Pre-requisite Installations Guide (Detailed) 
The steps outlined below, while applicable to most windows configuration, may vary on each machine based 
on an organization’s environment variables.  It is suggested that these pre-requisites are installed by an IT 
representative.  These are not in any specific order and are just for reference.  Please see Preferred 
Installation Order above. 
 
** Please contact the Examiner Help Desk at ehelp@fdic.gov or 1-877-334-2999, then option 2 with any 
questions ** 
 

1 - .NET Framework – KB3026376 

UPDATE (3/4/16) 

A recent Microsoft Security Patch (February) appears to be upgrading the .NET Framework to 4.6.1 automatically.  The 

ETS Maintenance team has not yet had a chance to evaluate this - therefore we cannot guarantee ETS on this platform.   

You may also notice that KB2974336 (in ETS-FREDDY) no longer appears as installed.  That particular KB package was 

designed specifically for .NET 4.5, 4.5.1 and 4.5.2 – this is an expected result.   

Plans for testing are being discussed now and an update will likely be available in v2.1 of this checklist. 

Please contact the Examiner Help Desk for further assistance. 

The .NET Framework is a key component and should not be changed without implicit instructions.  To install version 

v.4.5.2 – install the Microsoft Hotfix Rollup (KB3026376).  This is a cumulative rollup and includes several additional KB 

packages – specifically KB2974336 – which fixes a known defect in ETS.   

a) Begin installation (copy files locally rather than running from a network drive) 

 

b) Select ‘I have read and accept the license terms’, then Install. 

mailto:ehelp@fdic.gov
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c) Installation should be quick (no more than 5 minutes) 
 

 
 

d) Installation is complete – *Restart the computer now* 
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e) Verify installation from ETS-FREDDY or Programs and Features.  Take close note of the product 
version number – 4.5.52282 – and the Title – “Microsoft .NET Framework 4.5.2 Hotfix Rollup 
(KB3022670)” 

 

 

2 – ETS (KB2779272) 

This update adds support for some new glyphs, features and common fonts in Windows 7.   

Download package from http://support.microsoft.com/kb/2779272 and follow installation instructions 

3 – SAP Crystal Reports (64-bit – Service Pack 10) 

a) Double-click to begin installation 

http://support.microsoft.com/kb/2779272


ETS Pre-requisite Checklist (STATE) 
Version 2.0 

3/4/2016 

Do not alter or change the document without permission by the FDIC.   Page 8 of 28 

 
 

b) Select ‘I accept the License Agreement’, then Next.

 
 

c) Next 
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d)  

 
 

e) Finish 
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4 – SAP Crystal Reports (32-bit – Service Pack 2) 

 
The 32-bit version of Crystal Reports is only a requirement if you want to use ETS-ALERT.  Although most computers are 
already on a 64-bit Operating System, ETS-ALERT is a 32-bit application.  If this is not installed, ETS-ALERT will not open. 
 
a) Double-click to begin installation 

 
 

b) Select ‘I accept the License Agreement’, then Next. 
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c) Next 
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d) Finish 
 

 
 

5 – PDFNet Driver 1.0 

PDFNet is a print driver that ETS uses to produce several reports.   
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a) One way to install PDFNet is with ETS-FREDDY.  When running as an administrator, navigate to the ‘Tools’ 
tab and select ‘Install PDFNet 1.0’ 
 

 

b) Alternatively - download the PDFNet 1.0 Driver from http://pdftron.com/downloads/pdfnetDrivers.zip and begin 
installation 
 

 
c) Follow the installation wizard: 

 
 
d) Keep this file location, click Next 
 

http://pdftron.com/downloads/pdfnetDrivers.zip
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e) Click ‘Close’ and verify installation was successful by running ETS-FREDDY checks again. 
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6 – URL/ACL Reservation of Port :5555 

The easiest way to run this is by applying the “Fix” within ETS-FREDDY.  Run the Post-Install Check, and if the URL/ACL is 

not configured properly, the “Fix” button will become highlighted – or run the script below as an administrator. 

 

7- SQL Server (2008 AND 2012) Silent Installation 
Applying prerequisites through imaging: 

Many states used an image process to install the prerequisites of ETS-ALERT.  A similar process can be used with these 

prerequisites.  The ETS application, however, cannot be installed through an image process.  Each end user must install 

ETS under his or her user profile.  If ETS is installed by an IT admin, the user will not be able to use ETS. 

Before beginning installation of SQL: 

1. Login as an administrator 

2. Reboot the machine.  If the target machine has a reboot pending from any previous software installation, 

etc. (identified by checking registry key HKLM\SYSTEM\CurrentControlSet\Control\Session Manager), the 

machine must be rebooted prior to attempting to install SQL Server. 

Installation Steps: 

1. Save the .bat file and the config.sql file to the desktop on the target machine. 

o Edit each file to reflect the appropriate changes below. 

2. Download the version of SQL Server you wish to install and place in the same folder with the .bat & config files.  

o SQL2008: http://www.microsoft.com/en-us/download/details.aspx?id=30438  

o SQL 2012: http://www.microsoft.com/en-us/download/details.aspx?id=43351 

3. To begin the installation – execute (double-click) the .bat file. 

http://www.microsoft.com/en-us/download/details.aspx?id=30438
http://www.microsoft.com/en-us/download/details.aspx?id=43351
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4. After installation is finished – execute the config.sql file within SQL Server Management Studio. 

.BAT FILE 
 

"SQLEXPRADV_x64_ENU.exe"  <-- Same file name for SQL2008/SQL2012   
/QS 
/ACTION=Install 
/IACCEPTSQLSERVERLICENSETERMS 
/FEATURES=SQL,TOOLS 
/INSTANCENAME=FDIC2008  
/SQLSVCACCOUNT="NT AUTHORITY\Network Service" 
/SQLSYSADMINACCOUNTS="yourdomain\YourAdminGroup"' <-- Change this to your own group or individual 
/AGTSVCACCOUNT="NT AUTHORITY\Network Service" 
/RSSVCACCOUNT="NT AUTHORITY\Network Service" 
/ISSVCAccount="NT AUTHORITY\Network Service" 
/ASSVCACCOUNT="NT AUTHORITY\Network Service" 
/FILESTREAMLEVEL=2 
/FILESTREAMSHARENAME="FDIC2008"  

 
 
After making the configuration changes, return the file to its original state by:  

• Restore the text to one continuous string (with a single space preceding each slash "/"  

o In the actual .bat file, the above will appear as a continuous string of unbroken text.  For viewing 

purposes, we have broken up the text string into the lines above. 

• Save the file 

• Confirm the file extension is ".bat" (and was not changed to .txt when you edited) 

 
CONFIG.SQL FILE 
 

The config.sql file contains the text in the grey box below. Note the bold, blue item in the text. "etsusers" is an Active 

Directory network group within FDIC's "prod" domain. This set of commands assigns users within these groups to the 

database's "dbcreator" and "bulkadmin" roles. You must alter these commands to reference the appropriate group 

names (or usernames) for your organization.  Do not leave the blue text unchanged; it is specific to the FDIC’s 

environment. The dbcreator and buildadmin roles are required by your examiner end-users.  So, for agencies using 

Active Directory, add the domain and Active Directory groups that contain your population of users who will access ETS.  

Using Active Directory makes the process of adding users to these database roles much simpler.  Instead of adding users 

separately in this script (which would require editing for each user), adding the right Active Directory groups will 

authorize any users in those groups to perform the actions required in ETS. 

 

exec sp_addsrvrolemember [prod\etsusers],'dbcreator' // <-- Change to your own group or individual  
go 
exec sp_addsrvrolemember [prod\etsusers],'bulkadmin'  // <-- Change to your own group or individual  
go 
exec sp_configure 'show advanced options', 1; 
go  
RECONFIGURE; 
go 
exec sp_configure 'clr enabled', 1; 
go 
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RECONFIGURE; 
go 
EXEC sp_configure filestream_access_level, 2; 
go 
RECONFIGURE; 
go 

 

How to execute the config.sql: 

1. Open Microsoft SQL Server Management Studio and click “connect” 

2. Once connected, click “open file…” from the “File” menu. 

3. Navigate to the config.sql file. The text of the config.sql file should appear in the center pane. Once the text is 

displayed, click the “Execute” button (red exclamation point). The command should run and a successful 

indication should appear near the bottom of the screen. 

4. Exit Microsoft SQL Server Management Studio 

How to Execute the config.sql via Command Prompt: 

The config.sql script described above may be run via the command prompt. If so, add the text “exit” to the bottom of 

the script before running the script from the Command Prompt.  Place config.sql in the following location: 

Drive:\program files\Microsoft SQL Server\100\Tools\Binn  Once moved, run the following command from the 

command line: 

Drive:\[location specific to your configuration]\sqlcmd.exe –S .\FDIC2008 –E –i “config.sql 

 

8 – Microsoft SQL Server 2012 Express – Service Pack 2 (Upgrade from SQL 2008) 

 
Microsoft SQL Server is a Database Management System that ETS uses to operate.  This section is going to describe, in 
detail, how to upgrade the SQL Server platform from 2008 to 2012.  If you have not installed SQL 2008 on the machine, 
please go back and install before continuing. If this is not installed with the proper configurations, ETS will not open.   
 

Manual Installation 
 
1. Once SQL 2008 has been installed successfully, you will need to perform an upgrade rather than a new installation.  

The screenshot below will appear once you have initiated the installation of SQL 2012 (manually).  Select ‘Upgrade 
from SQL Server 2005, SQL Server 2008 or SQL Server 2008 R2.  Follow the steps below: 
 
**Alternatively, you can perform a New SQL Server Installation from this same installation wizard** 
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2. Select “I accept the license terms’.  Do not elect to ‘Send feature usage data…’  
 

 
 
3. For best results, do not include SQL Server Product Updates (this will automatically update your SQL Server 

version with the latest version available which could cause unknown issues with ETS) 
a. This option may not be available for some users and will skip over this automatically. 
b. Installing Service Pack 3 for SQL Server 2012 will also upgrade the database and will 

automatically include you in the upgrade feature. 
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4. The next section is an important section.  If you have multiple instances of SQL Server installed, make sure 

you choose ‘FDIC2008’ from the drop down menu then click Next. 
**Other notes: 
 - SQLEXPRESS  default instance created by SQL Server 
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5. Do not send information to Windows – ensure check box is unchecked – then click Next. 
 

 
 
6. After the step above is completed, there will be an Upgrade Rules check that will run automatically.  If any 

errors are detected, they will be identified and installation will stop.  Make the necessary fixes and restart 
installation.  If successful, the installation will continue. 
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7. Success!  Close out of the installation and open SQL Server 2012 Management Studio. 
 

 
8. When you open SQL Server 2012 Management Studio – it will ask if you would like to import customized 

user settings from SQL 2008 – choose YES. (This is optional and will only appear if you chose to upgrade 
from SQL 2008) 
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9. All of the database configurations (database, logins, server roles, etc.) will be imported.  If you had an ETS-
ALERT database before-hand, you will notice the database was imported successfully! 

  

10. Download ETS from the ClickOnce website: https://ets.fdic.gov/ets/ and consult ETS-FREDDY if any other 
issues arise during installation. 

 
.BAT File for Upgrade 
You can also upgrade SQL Server using a batch file in the same manner as before.  Follow the same guidelines that were 

used for SQL 2008.  

 

/Q  
/ACTION=Upgrade  
/IACCEPTSQLSERVERLICENSETERMS  
/INSTANCENAME="FDIC2008" 
 /ISSVCAccount="NT AUTHORITY\Network Service"  

 
 
After making the configuration changes, return the file to its original state by:  

• Restore the text to one continuous string (with a single space preceding each slash "/"  

o In the actual .bat file, the above will appear as a continuous string of unbroken text.  For viewing 

purposes, we have broken up the text string into the lines above. 

• Save the file 

• Confirm the file extension is ".bat" (and was not changed to .txt when you edited) 

Execute the .bat file 

• Place the .bat file in the same location (C:/Users/%LocalUser%/Downloads) as the SQL Server 2012 

executable file (SQEXPRADV_x64_ENU.exe) 

• Double-click to execute the .bat file 

 
 

  

https://ets.fdic.gov/ets/
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Appendix B: Local Configuration of Port :5555 
ETS uses a unique method to allow communication within the application.  In order to perform peer-to-peer 

collaboration, port :5555 needs to be configured locally on each machine. To configure this port, you’ll need to run the 

following script as an administrator.  Copy the information below into a text file – when saving the file be sure to save it 

as a .cmd file. 

@echo off 

set type=BUILTIN 

set group=USERS 

call :concat %type% %group% 

netsh http del urlacl url=http://+:5555/ETSCollaboration > nul: 

netsh http add urlacl url=http://+:5555/ETSCollaboration user="%fullGroupName%" > nul: 

if %ERRORLEVEL% == 1 goto error 

netsh http show urlacl 

pause 

goto end 

:error 

echo. 

echo Error creating new url acl - are you running as admin? 

echo. 

goto end 

:concat 

set fullGroupName=%~1\%~2 

:end 
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Appendix C: Firewall Configuration 
Generally speaking, ETS uses port 5555 for inbound TCP traffic and 3702 for inbound/outbound UDP traffic.  Firewall 

rules must be in place that allows both inbound and outbound traffic.  The screenshots and instructions below are for 

Windows Firewall.  You may need to modify these if you are using different software. It is likely that examiners will not 

be able to change these settings; they will likely require administrative rights.  

1.       Open Windows Firewall with Advanced Settings 

a.       Right-click on either Inbound Rules or Outbound Rules in the upper left corner and select New Rule. 

b.      Select the Port radio button and enter “5555” (or UDP for Specific Local Ports, then select Next.) 

c.       Select the Allow the Connection radio button, then select Next. 

d.      Check the boxes for Domain, Private, Public profiles, then select Next. 

e.      Name the new rule. I used the name TCP 5555 but you may choose any name. 

f.        Click Finish. 

2.       Locate your new rule in the body of the screen. 

a.       Right click your new rule and select Properties. 

b.      Edit each tab in the Properties menu as follows: 

 

c.         
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d.       

e.       
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f.         

g.        
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Note: port 5555 only needs to be open for local non-routable IP addresses. This is required for peer-to-

peer collaboration over an ARUBA (or another similar device). 

 

h.      The settings options for the Computers and Users tabs can remain unchecked, which is how they 

default. 

 

i. You can use these same instructions to set up the 3702 exception – just replace 5555 with 3702. 

 

j.         Once you have changed the properties of your newly created rule to mirror the screenshots above on 

each tab (except Computers and Users), click  Apply. 
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Appendix D: ETS-ALERT Database Deployment Workaround for SQL 2012 
After upgrading SQL Server to 2012, the ETS-ALERT database (FDIC_ETS) will not publish to SQL Server like it 

did in 2008.  A key component – SQL Compact (CE) – must be installed before upgrading to SQL 2012.  If either 

the 32-bit and 64-bit components are missing, ETS-ALERT may not work!  

As a workaround, we have created a script that will install the database via a SQL query.  The script is available 

on the CSBS website and can also be acquired by contacting the Examiner Help Desk (ehelp@fdic.gov , or 1-

877-334-2999, then option 2) 

1. Extract all files (.bat & .sql) to the desktop.  The .bat file calls upon the .sql file, so both files need to be 

in the same location for the script to work. 

 
2. Verify there is not a FDIC_ETS database already present. 

3. Double-click the .bat file to execute the script.  

a. A command window will appear and begin running the script.  Once it's finished, the cmd 

window will close automatically 

 
 

4. Open ETS-ALERT 

mailto:ehelp@fdic.gov

